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Introduction 
 

e-cat works within MS-Word to create structured XML and HTML 
documents.  E-cat creates documents by describing them using XML 
and HTML metadata.  Metadata is data about data. It describes the 
data and holds information such as who created it and what it is about. 
In e-cat you provide metadata that describes learning resources such 
as: 

• documents • pictures 

• sections of documents (defined by headings) • objects 

Metadata allows the documents to be easily found, reused and 
reworked to suit the learner and learning method.  Pictures, objects can 
be added onto an e-cat document.  E-cat prompts you for metadata 
when these are added so that they are correctly handled.  The version of 
e-cat you are using is 2.1.0. 
 
The e-cat Process 

When you use e-cat to create a document you work through a process. 
This process is shown in the diagram below (not necessary to carry them 
in this order). The steps are described on the following page.   
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Downloading e-cat 

You can download e-cat from 
http://www.leedsmet.ac.uk/inn/streamline/documents/e-cat-2.1.0.zip 

On the dialog box, click Open to start downloading.  Once that is done, 
run setup.exe file to install e-cat. 

What to do if the e-cat menu is missing from MS Word 

Yes, strangely this can happen but do not panic!  There are 2 things you 
can do: 

1. From MS-Word Tools menu, click on Templates and Add-Ins… You will 
see the dialog, as shown on the following screenshot: 

 

 

2. Tick the hud_format.dot box to select the template and click OK. 
3. Make sure that the macro security is set to low.   From MS-Word Tools 

menu, click on Macro and select Security…  In the Security dialog 
box, click on Low radio button and click OK.  The e-cat menu would 
appear now. 

 
What to do if macros are disabled 
 
If when you open MS-Word there is a message saying the Macro has 
been disabled due to Security reasons you will need to enable the 
Macro.  

1. From MS-Word Tools menu, click on Macro and select Security…  In 
the Security dialog box, choose the second tab Trusted Sources.  
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2. Tick the box of trust all installed add-ins and templates at the bottom.  

! If the trust all installed add-ins and templates box is already ticked 
delete the tick and tick it again!  

3. Close down Word to make the change take effect.  
4. Reopen Word to start your work. 
 
Step 1 Creating/Renaming a Document 

Do not use File menu or New Blank Document command to create a 
document.  Instead, use the e-cat menu and select New document.  The 
Save As dialog displays - save your document.   

! Use this function when wanting to rename a document.  Do not 
forget to save this under a new folder to avoid confusion! 

 

An e-cat dialog asks whether you want to create a Metadata template. 
Metadata templates let you set up metadata that you can apply to 
many documents. 

1. If you want to create a template, click Yes and read Step 5.  For more 
information, click Help on the e-cat menu.  Click on contents tab and 
on Metadata Templates.  Choose the appropriate section for 
assistance. 

2. If you want to continue creating the document, click No. 

You have created your document. Behind the scenes, e-cat has created 
a directory structure where all of the associated files will be stored. 
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Step 2 Adding Text 
 
If you are new to e-cat, it is better to produce your document text in MS-
Word and then paste the text into your e-cat document. 
 

! You must not paste objects or pictures!  This must to be done via the 
e-cat menu function Insert picture. 

 
Step 3 Setting Document Structure 

Now add headings to text using MS-Word command – Styles and 
Formatting.  This breaks your document down into separate HTML or XML 
pages in the output. 

Make sure that you set the Outline Level to either Level 1, 2 or 3 for each 
level heading!  This can be done under Styles and Formatting – New Style 
/ Modify Style – Format – Paragraph – Outline Level. 

! It can be difficult to scroll through long pages online; by using this 
feature you can break your document into smaller, more useable, 
online pages. 

You can cause new pages to be created at the following points: 

• Level 1 (e.g. Heading 1)  
• Level 2 (e.g. Heading 2)  
• Level 3 (e.g. Heading 3)  

! By choosing the Section level, your document will be on one HTML 
page. Navigation links will jump you down the page. 

 
Placing text into tables is not necessary but it will ensure a more readable 
and appealing document.  Some pointers to follow when doing so: 

1. Set borders to None on the tables. 
2. Avoid putting headings inside tables. Use tables for normal text, 

objects and pictures. 
3. Avoid putting tables too close together. Leave two empty lines 

between adjacent tables. 
4. Avoid nested tables. In other words do not put tables inside other 

tables. 
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Step 4 Adding Pictures/Objects 
 
When you insert any of the following: 
• Pictures 
• Movies 
• Animations 
• Slideshows 
• Audio files 

• Multimedia 
• HTML pages 
• PDF Files 
• Spreadsheets 

into your document, you must insert them using the e-cat.  Using the e-
cat menu allows e-cat to: 

1. Copy the object or picture into e-cat folder: ideally in the assets 
folder – objects subfolder (so that e-cat can ensure that they are 
displayed correctly in your outputs). 

2. Set parameters, such as the preferred viewer, for objects. 
3. Prompt you for metadata for the object or picture. 

Inserting a picture 

1. Choose the e-cat menu and select Insert picture. The Insert picture 
dialog displays. 

2. Click the Browse... button and browse for the picture that you want to 
insert. 

3. Select the picture and click the Open button. The picture that you 
have chosen is displayed in the Insert picture dialog. 

4. If you want to prevent the image from being resized in Word, tick the 
Keep original image box. 

! It is possible to resize the image in Word but doing so will not alter the 
size of the image that is used in the output. 

5. You should now add metadata to the picture (see Step 7). 
6. When you click Save in the Metadata dialog you will return to the 

Insert picture dialog. Click OK. Your picture is displayed in the 
document. 
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Inserting an object 

1. Choose the e-cat menu and select Insert object. The Object dialog 
displays. 

2. Choose the Create from File tab. 
3. Click the Browse... button and browse for the object that you want to 

insert. 
4. Select the object and click the Insert button. You will return to the 

Object dialog. 

! Do not use the Link to file or the Display as icon options.  If you need to 
edit an object you should remove it from the document, edit it and 
then re-insert it into the document. 

5. Click OK. The Object Selection dialog displays.  The folder path and 
file name of your object are displayed in the File name field. 

6. If you are given a choice choose the preferred player for the object 
from the Player selection pane. 

7. When the player is chosen the Player Parameters pane shows default 
parameters for this type of player. You can edit these parameters. 

! Parameters may include information such as whether or not the 
object should play on a loop.  These parameters are normally set by 
e-cat, if you want to edit them, refer to the documentation for the 
chosen player. 

8. If the object is an audio file tick the Audio file box.  This helps e-cat to 
distinguish between audio and video files. 

9. You should now add metadata to the object (see Step 7). 
10. When you click Save in the Metadata dialog you will return to the 

Object Selection dialog. 
11. Click OK.  You have inserted your object. 

! e-cat can pose problems inserting video/audio objects in various 
ways!  If so, do the following. 
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What to do if e-cat does not allow you to insert an object 
 
1. Check the name of the file.  I.e. try renaming the file video.AVI  to 

video.avi as there is a bug in the code which prevents it accepting 
.AVI files (could try this on other extensions - .wmv, .wav). 

2. The object file size can pose a problem as well.  Try reducing the file 
size to below 10Mb or you can insert a hyperlink to the object.  Place 
cursor at appropriate position.  Use the MS-Word command Insert | 
Hyperlink.  Select the file in the middle window of the dialog and write 
some suitable text in the Text to display box.  Click OK.  A link will be 
attached at the position that you started.  An example is shown in the 
following screenshot: 

 
 
Inserting a logo 

1. Choose the e-cat menu and select e-cat Customise – Logo change.   
The Logo change dialog displays. 

2. Click the  button and browse for the image file (i.e. .jpeg or 
.gif) that you want to insert. 

3. Select the file, click the OK button and click the Close button.  
4. Your selected logo will be displayed when you preview or display your 

output (see example below with the logo appearing on the top left-
hand corner). 
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Step 5 Adding Metadata to Documents 
 
These steps describe how to add the metadata to your document 
manually.  You can also add data using the Metadata Wizard.   
Select Metadata template via the e-cat menu function.   E-cat forces 
you to enter all details under General and Author Details tabs so please 
ensure that these sections are completed! 
Work through each of the tabs on this dialog and fill in the appropriate 
fields.  The screenshots below will provide you examples of information 
that is required as metadata under each of the tabs. 
For additional help, click Help on the e-cat menu.  Click on contents Tab 
and on e-cat Dialogs.  Choose the appropriate section for assistance. 

! Keyword searches use Boolean AND logic i.e. evaluation, observation, 
user will return only pages with all 3 keywords in it! 

 Make sure every keyword is therefore separated by the comma. 
 Appropriate keywords ensure that your document and its objects can 

be found and reused.  It should contain single words or phrases. 
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Step 6 Applying a Metadata Template 

Metadata templates enable you to save time by using 'boilerplate' 
metadata for similar learning resources. You can add metadata by using 
a template, and then edit this metadata to fit each specific resource. 
You can apply metadata to: 

• Globally 
• Specific resources 

Applying a Global Metadata Template 

1. Choose the e-cat menu and select Metadata template. The 
Templates dialog displays. 

2. Choose the Select tab. 
3. Select the Metadata template that you want to apply from the 

Available Templates list. 
4. Click OK.  The Metadata template is applied.  The following resources 

will now use the metadata from the template: 

• Resources that you have not applied metadata to. 
• Any new resources that you add. 

! The global template never affects resources that you have already 
added metadata to. 

To apply a Metadata Template to specific resources, follow step 7 below. 

Step 7 Adding Metadata to Pictures/Objects 
 
Right-click on the picture or object that you want to add metadata to. 
Choose Metadata for Picture/Object from the right-click menu.  The 
Metadata dialog displays. 

1. Click the Templates... button.  The Templates dialog displays. 
2. Choose the Select tab. 
3. Select the Metadata Template that you want to use from the 

Available Templates list.  Click OK. 
4. You will return to the Metadata dialog. The metadata from the 

template has been added to this dialog. 
5. Work through each of the tabs on the dialog and check or fill in the 

appropriate fields.  The screenshot below shows you an example of 
the information that is required as metadata under each of the tabs.   

6. When you have finished checking and adding metadata, click the 
Save button.  Your metadata is added to the resource. 
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! You must change any metadata from the template that does not 
apply to the resource. You may also need to add metadata that is 
not in the template. 

Step 8 Previewing Outputs 

Previewing your output generates a version of your output without asking 
you to choose: 

• an online format  
• a section level for breaking the document down into pages. 

This should be quicker than actually creating your output.  For more 
information, click Help on the e-cat menu.   To preview your output: 

1. Choose the e-cat menu and select Preview; e-cat creates your 
output. 

! While this happens the Progressing message dialog displays a blue 
progress bar. Depending on the size of your document (including 
objects), this process may take a little time. 

 

   ,
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2. When e-cat has created your output, the output is displayed in your 
default web browser (unless if your browser is set to block active 
content – if so read on!) 

What to do if your browser is set to block active content 
 
1. You will see an Information Bar appear (see screenshot below).  You 

can turn off the Information Bar in Internet Explorer by lowering the 
default security settings. However, you should leave these security 
settings at their default level or higher to help protect your computer 
from viruses and from attacks over the Internet. 

2. You can temporarily allow blocked content by right-clicking your 
mouse and choosing Allow Blocked Content …  You will get a Security 
Warning dialog, click Yes to display content without restrictions. 
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Step 9 Creating Outputs 

Using e-cat, you can output your document as one of three online 
formats. You can also break your document down into separate HTML or 
XML pages in the output.  To create your output: 

1. Choose the e-cat menu and select Format conversion. The Output 
Selection dialog displays. 

2. Set these 2 choices: 

• Section level  • Output formats  
 

! By choosing the Section level, your document will be on one HTML 
page. Navigation links will jump you down the page. I.e. choosing 
section level 2 starts each page from a Level 2 heading that you 
have set. 

! It is recommended that you select the CD or WEB output format.  E-cat 
displays the output in your default web browser when it is finished. 

3. Click OK. 
4. The Metadata dialog displays showing the metadata for the 

document.  You can now add or view and edit metadata. When you 
are happy with the metadata for the document, click the Save 
button. 

5. When you click the Save button, e-cat creates your output.   
6. While this happens the Progressing message dialog displays a blue 

progress bar. Depending on the size of your document, this process 
may take a little time. 

7. If you are happy with your output, you can now distribute your files. 
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Step 10 Distributing your Files 

When you create outputs, e-cat creates a ZIP file for each output that 
you create. This ZIP file contains the files necessary to use your output. 

To distribute your files: 

1. In Windows Explorer or My Computer find the folder that you created 
when you created the document. 

! This folder will have the same name as the document. 
2. Open the folder. You should see several folders created by e-cat. 

Open the delivery folder. 
3. In the delivery folder you should see a ZIP file for the CD or Web(HTML) 

output format you have created (see screenshot).   This output is an 
HTML version of your document with a table of contents and 
hyperlinks to help your users to navigate through the document. 

 

4. The files are named according to the following convention: 
DocumentName.xml_cdpackage.zip is the CD or WEB(HTML) output. 

5. If you want to place the files in a shareable repository, the YH 
Learning repository can be used to start!   

6. You can upload files directly (if large sized) by logging into website  
http://www.yhlearning.org.uk/. Username and Password for the 
repository is training@kainao.com.   

7. Click Upload packages.  Select Leeds Metropolitan Col as 
Organisation.  Click Browse to select Package Files(s):  

8. Select the DocumentName.xml_cdpackage.zip file and click Upload 
File.  Beware that this process can take up to 30 minutes depending 
on your file size. 

9. You can also mail your ZIP files (if under 4Mb) to 
yhlearning@kainao.com.  The technicians will extract the files and 
place them in the repository but please allow at least a day for them 
to upload your material!   

10. You can put the files into your file storage on WebCT though they will 
not be searchable using the keywords that you specified. 

! Do access the faq page on the web site for various answers to 
queries! 
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Uploading e-cat materials into Blackboard VLE 

1. Format the e-cat document as CD or WEB(HTML) output.  
You will see the zip file as in the screenshot above.  

2. Log into your Blackboard VLE and select a module from your Course 
List. 

3. Click on Build tab at the top left-hand corner. 
4. Click on File Manager on the left bar.  Create a folder by clicking at 

Click Folder.  Enter an appropriate title and click OK. 
5. Now, click Get Files, My Computer tab, and upload the delivery folder 

zip file into My Files as you would with any file.  
6. Click on the folder you just created, click Get Files, tick the uploaded 

zip file and click OK.  
7. Unzip the files now by clicking the ActionLinks button .  Select 

Extract from list.  Upon extraction, click on the extracted e-cat folder 
and in the subfolder htm, select the index.htm file to view your 
learning object. 

Adding your Learning Object onto Blackboard Student View 

1. Click on Build tab and on the  button.  Select Browse 
for Files and on the Class Files tab.   

2. Click on the folder you created earlier and in the subfolder htm, tick 
the index.htm box and click OK. 

3. You can now view your learning object under the Student View tab. 

Enjoy creating your learning object! 
 
Mekala Soosay 
Innovation North 
Caedmon 202, Ext. 23735 
Leeds Metropolitan University 
Headingley Campus,  
Leeds LS6 3QS 
Email: m.soosay@leedsmet.ac.uk 
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